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ABSTRACT
Alzheimer’s disease (AD) is a complex, multifactorial, progressive, neurodegenerative disease primarily
affecting the elder population and is estimated to account for 50–60% of dementia cases in persons over
65 years of age. Natural products, including plants, animals and minerals have been the basis of
treatment of human diseases. Secondary metabolites have been the most successful source of potential
drug leads and continue to provide unique structural diversity in comparison to standard combinatorial
chemistry, traditional medicinal practices have formed the basis of early medicines followed by
subsequent clinical, pharmacological and chemical studies which provides opportunities for discovery
for many novel low molecular weights lead compounds. In silico approach has been of great importance
as a versatile tool to develop fast and accurate target identification and prediction method for the
discovery. Traditionally docking was used as computational tool for screening databases of natural
products to mine a set of a few candidate drug-like compounds. Reverse docking was a comparatively
new application of docking in which a database of proteins (drug targets) was docked against a set of
natural products to predict binding affinities. Therefore, plant extracts may in future provide more
effective medicines than the single purified natural products of modern medicine, in some cases. Studies
on identification of compounds from traditionally used medicinal plants to cure neurodegenerative
diseases and brain injuries is increasing scientific interest in recent years as this a major concern in
public. In Ayurveda the roots, seeds and leaves of Clitoria ternatea have been widely used as brain tonic
and believed to promote memory and intelligence. Hence the present study was designed to assess the
Alzheimer’s activity of Clitoria ternatea and to identify and isolate the major bioactive constituent
attributing the activity.
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INTRODUCTION
Alzheimer’s disease (AD) is a complex,
multifactorial, progressive, neurodegenerative
disease primarily affecting the elder population
and is estimated to account for 50–60% of
dementia cases in persons over 65 years of age.
The impairment of central acetylcholine (ACh)
neurotransmission due to neural degeneration
is believed to be a principal neuropathological

feature of Alzheimer’s disease. AD occurs in two
forms: familial and sporadic. In familial AD,
mutations in the amyloid precursor protein
(APP), presenilin 1, and presenilin 2 genes are
the currently known causal factors. Familial AD
constitutes only a small portion (2-3 %) of all AD
patients and it has an early age of onset
(younger than 65 years). On other hand,
sporadic AD, constitutes a vast majority of AD
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cases and is associated with a late age of onset
From ancient times “Shankhpushpi” is known as
(65 years and older). Although the specific
reputed drug of Ayurveda and reported as a
causes of sporadic AD are still unknown many
brain tonic, nervine tonic and laxative. It is
causal factors seem to be involved in sporadic
considered as a “Medhya Rasayana” in
AD, including aging, mitochondrial defects,
Ayurveda. It is an Ayurvedic drug used for its
insulin-dependent diabetes, environmental
action on the CNS (Central Nervous System),
conditions and diet. In familial AD, genetic
especially for boosting memory and improving
mutations accelerate the disease process,
intellect. The flowers of the plant Clitoria
whereas in sporadic AD due to absence of
ternatea resemble a conch shell; therefore it is
genetic mutation, cellular changes that control
commonly called “Shankhpushpi” in the
AD progression take more time to develop. AD
Sanskrit language where it is reported to be a
progresses gradually and can last for decades.
good “Medhya” (brain tonic) drug and,
Enzymatic hydrolysis of acetyl choline (ACH) is
therefore, used in the treatment of “Masasika
an important step in the nerve transport, and
Roga” (mental illness). Extracts of this plant
[1, 2, 3]
its defect results in Alzheimer’s disease.
have been used as an ingredient in Medhya
Ellmann’s method is used for determination of
Rasayana, are juvenating recipe used for
Cholinesterase activity and also for monitoring
treatment of neurological disorders. [7]
of the ACH hydrolysis by acetyl cholinesterase.
The original colorimetric procedure is based on
HABITAT AND DISTRIBUTION
the reaction of thiocholine (one of the products
Clitoria comprises 60 species distributed mostly
of enzymatic hydrolysis of ACTH) with DTNB,
within the tropical belt with a few species found
forming yellow colour product5-mercapto-2in temperate areas. The plant is well adapted to
nitrobenzoic acid. The maximum absorption
various climates. The plant originated from
coefficient found at 412nmThe reaction is
tropical Asia and later was distributed widely in
shown below:[4]
South and Central America, West Indies, China
Acetyl thiocholine → thiocholine + acetate
and India. [8]
Thiocholine + Dithiobis-Nitrobenzoate → 5mercapto-2-nitrobenzoic acid (yellow colour)
PLANT DESCRIPTION
Clitoria ternatea has twining fine stems 0.5-3 m
PLANT PROFILE [5]
long. The leaves are pinnate with 5-7 elliptic to
Botanical
Name:
Clitoria
ternatea
lanceolate leaflets 3-5 cm long and shortly
Common Name: Butterfly pea, Blue pea and
pubescent underneath. Flowers are solitary,
Cordofan pea
deep blue to blue mauve; very short pedicellate
Synonyms: Asphota, Girikarni, Visnukranta,
and 4-5 cm long. Pods are flat, linear, beaked, 6Sankhapuspi,
Sephanda,
Sveta,
Maha
12 cm long, 0.7-1.2 mm wide and slightly
Family: Fabaceae
pubescent with upto 10 seeds. The seeds are
[6]
whole plant
olive, brown or black in colour, often mottled,
4.5-7 mm long and 3-4 mm wide. [8]
Table: Taxonomical Classification [6]
Kingdom
Plantae
Order
Fabales
Family
Fabaceae
Genus
Clitoria
Species
ternatea
THERAPEUTIC USES
HISTORY
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The juice of flowers is reported to be used in
Aqueous extract preparation (AQE): The dried
insect bites and skin diseases. The roots are
marc was mixed with 300 ml of distilled water
useful in asthma, burning sensation, ascites,
in a reflux condenser for 3-4 hrs. The extract
inflammation, leucoderma, leprosy, hemicrania,
obtained was filtered and evaporated to
amentia,
pulmonary
tuberculosis,
dryness to yield aqueous extract of CT. All the
ophthalmology and reported as bitter,
dried extracts obtained were weighed and yield
refrigerant, ophthalmic, laxative, diuretic,
of each extract calculated.
cathartic, aphrodisiac, tonic. They are
considered safe for colic, dropsy and
IN
VITRO
FOR
ANTICHOLINESTERASE
enlargement of abdominal viscera. The root,
INHIBITION ASSAY (ELLMANN’S METHOD) [11, 12,
13, 14]
stem and flower are recommended for the
treatment of snake bite and scorpion sting in
PREPARATION OF SAMPLE SOLUTION OF
India. [7, 9]
CLITORIA TERNATEA
50 mg of each extracts was weighed and was
METHODS AND MATERIALS
dissolved in 50 ml of water to produce 1mg/ml.
COLLECTION AND IDENTIFICATION OF PLANT
From the stock solution, various concentrations
MATERIAL
ranging from 25 to100 µg/ml were prepared.
Dried Roots of Clitoria ternatea (CT) were
collected in February 2013 from commercial
PREPARATION OF 0.1M PHOSPHATE BUFFER PH
market, Attingal, Thiruvananthapuram, Kerala.
7.4
The plant material was identified and
5.44g of potassium di hydrogen phosphate was
authentified by Dr. K. V George, Department of
dissolved in 200 ml of distilled water and 0.84g
Botany, C M S College, Kottayam, Kerala. The
of sodium hydroxide was dissolved in 100 ml of
dried roots were pulverized by an electric
distilled water separately. From above solutions
blender and the coarse powder was stored in an
62.5 ml of potassium di hydrogen phosphate
air tight container.
was taken and was added 48.7 ml of sodium
hydroxide. It was made up to 200 ml with
PREPARATION OF EXTRACT[10]
distilled water.
Hexane extract preparation (HE): 100g
powdered root material of CT were macerated
PREPARATION
OF
SUBSTRATE
ACETYL
with 250ml of Hexane for seven days at room
THIOCHOLINE IODIDE (ATCI)
temperature and shaken occasionally for
0.02167g of acetyl thiocholine iodide was
extraction. The resulting extract was filtered
dissolved in 10ml of 0.1 M phosphate buffer
and the filtrate obtained was evaporated to
and stored in refrigerator for use.
dryness using a rotary evaporator to yield
hexane extract of CT. The marc was dried and
PREPARATION OF REAGENT 5, 5’-DITHIOBIS-2used for further extraction.
NITROBENZOIC ACID (DTNB)
0.0396 g of 5, 5’-dithiobis-2-nitrobenzoic acid
Alcoholic extract preparation (AE): The dried
and 0.015g sodium carbonate were dissolved in
marc was placed in a thimble and extracted
10 ml of 0.1M Phosphate buffer and used for
with 250ml of ethanol in a Soxhlet apparatus for
study.
72 hrs. The extract was filtered and evaporated
to dryness to yield Alcoholic extract of CT.
PREPARATION OF ENZYME
Venous blood was collected into dried
heparinized
tubes
and
subjected
to
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centrifugation. Plasma was removed carefully
Rigid docking was performed and hence,
without losing any erythrocytes. The
protein and the ligand molecule were nonerythrocytes are then suspended in water in a
flexible. Here Amyloid β protein (PDB ID: 4FRJ)
volume corresponding to the initial volume of
was used as receptor and ligand molecules
whole blood, followed by 60-fold diluted with
were all the constituents identified in the
H
buffer (0.1M Phosphate buffer P 7.4). Then the
aqueous extract of Clitoria ternatea using LCsuspension had frozen in order to haemolyse
MS.
the erythrocytes. [15]
PREPARATION OF RECEPTOR
METHOD
The Auto dock software was opened by clicking
To 0.4 ml of enzyme and 0.5ml 5, 5’-dithiobis-2on Auto dock icon from desktop.
nitrobenzoic acid, 0.4 ml of sample was added
The downloaded PDB molecule 4FRJ in the
and incubated for 15 minutes at 25oC. The
work space panel was read by clicking on the
reaction was then intitated with the addition of
tab “File”and then selected “Read molecules
0.1ml of acetyl thiocholine iodide. The rate of
absorbance was monitored at wavelength 412
Hydrogen Atoms and Charges
nm. The AchE inhibitory activity was calculated
The tools available in ADT were used to read
[12, 13, 15, 16]
using the equation:
coordinates in PDB and other formats, to add
hydrogen, to selected portions of the molecule,
A- (B-C)*100/A
and to add partial charges. These functions
were all accessed through menus at the top of
A represents Control (Reagents + solvent +
the ADT window.
Enzyme)
• File> Read Molecule: Opens a browser that
B represents Sample (Reagents + Sample +
allows reading of PDB coordinate files.
Enzyme)
• Edit> Delete: Several options for deleting
C represents Blank of Sample (Reagents +
entire molecules, selected sets of atoms or
Sample + solvent)
hydrogen atoms.
• Edit> Hydrogen> Add: Options for adding all
CHEMICAL
PROFILING
OF
BIOACTIVE
hydrogens or polar hydrogens.
(AQUEOUS EXTRACT) BY LC-MS METHOD
• Edit> Charges: Options for computing
Aqueous Extract was resuspended in water and
Gasteiger charges for arbitrary molecules.
used for LC-MS study. The Column used was
• File> Save> (receptor.PDBQT
Phenomenex RP 18, 25cm × 2.5mm and the
Mobile Phase Acetonitrile: Methanol in the
PREPARATION OF LIGAND
ratio 50:50 was used for the study. The
Prepared ligands can be processed in the
ionization mode used was Electron spray
“Ligand” menu to create the ligand PDBQT file.
ionization. Ionization range was at 50-1000. The
Ligand> Input> open: reads coordinates from a
Software used for identification Class was VP
file.
integrated Library (Metwin 2.0). [17]
Ligand> Input> choose: chooses a molecule
already read into ADT
DOCKING
STUDY
WITH
IDENTIFIED
Ligand> Torsion Tree> Choose Root: manual
COMPOUNDS FROM LC-MS WITH RECEPTOR
selection of the root atom.
[18, 19, 20]
4FRJ
Ligand>Torsion Tree> Detect Root: Automatic
STEPS INVOLVED IN AUTODOCKING
detection of the root that provides the smallest
largest sub tree.
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Ligand> Output: Opens a browser to write the
Docking>
Search
parameter>
Genetic
formatted ligand. PDBQT file.
Algorithm>( for first time short number of
evaluations and for other runs choose medium
GENERATION OF GRID
or long> accept: Setting the parameters chosen
For docking calculations using rigid receptor
for the docking method.
coordinates, the hydrogen atoms and charges in
Docking>docking parameters> choose the
ADT, were added.
defaults: Setting docking parameters.
Docking> Output> Lamarckian GA> dock.dpf:
OPENING THE RIGID PROTEIN
The name was specified on the ligand dpf file to
Grid> Macromolecule> Open: Launches a
be formed, containing the docking instruction.
browser to open an existing PDBQT file.
Grid> Macromolecule> Choose: Chooses a
RUNNING OF DOCKING
molecule that has been previously read into
Pwd Enter
ADT. Merged non-polar hydrogen atoms and
Cd folder: Enter
charges, assign aromatic carbons, and prompt
Cd folder (sub folder) Enter
the user to write a PDBQT file.
./autogrid4.exe –p grid.gpf –l grid.glg
./autogrid4.exe –p dock.dpf –l dock.dlg
PREPARATION GRID PARAMETER FILE
Visualization of docking was done by chimera.
Select> select from string > Residue> name of
active site found by Q site finder> add> dismiss:
ISOLATION OF BIOACTIVE CONSTITUTENT
Select the residue to be flexible.
DETERMINATION AND OPTIMIZATION OF
Display> label> by properties> select name and
SOLVENT SYSTEM BY TLC [21, 22, 23, 24]
number> from one or more properties> Ok.
PREPARATION
OF THE
THIN LAYER
Grid> grid box: Interactive commands were
CHROMATOGRAPHY (TLC)
launched for setting the grid dimensions and
The TLC plate was prepared by suspending silica
center. The numbers were entered on the
gel G powder in distilled water. The slurry was
thumb wheel, placed the cursor over the thumb
poured carefully on to the glass plate to get
wheel and type the new value. Right clicking on
uniformly coated plates. The plates were air
the thumb wheel gave more options.
dried and kept in an oven at 100-120°C about 30
IMPORTANT: when finished, use the “close
minutes for activation.
saving current” option in the “File” menu on the
Grid Options Panel. Options in the “Center”
DETERMINATION OF SOLVENT SYSTEM
menu on the browser provide different
SOLVENT SYSTEM
methods to choose the center of the grid box.
Different solvent systems viz Toluene: Ethyl
Grid> Output> save by grid.gpf: Save grid
acetate, Toluene: Chloroform: Ethanol, Ethyl
settings as gpf file.
acetate: acetic acid and Toluene: Ethyl acetate:
Acetic acid were tried out to select the suitable
PREPARING DOCKING PARAMETER FILE (.DPF)
solvent system for the identification of
Docking> Macromolecules> Set rigid filename
maximum chemical constituents present in
(choose receptor.PDBQT): Specifying the rigid
aqueous extract
molecules.
Docking>
Ligand>
choose>
(choose
THE COMPOUND ON TLC PLATE
ligand.PDBQT) > accept: Specifying the ligand
The origin is marked by drawing a thin line
molecules.
across the bottom of the plate with a pencil.
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The aqueous extract was spotted with a glass
Mixed with 100ml of Toluene: Ethyl acetate
capillary tube on to the plate.
(8:2) into the beaker was stirred well using a
glass rod to made slurry of the silica.
RUNNING OF TLC
Poured the slurry into the column.
The spotted plate was placed into the saturated
Placed a beaker below the mounted column to
chamber; preventing the sample from dissolving
drain out the excess solvent.
from the plate into the eluent layer. When the
Closed it when the level of the solvent reached
eluent reaches 3/4of the plate, the plate was
just above the settled silica gel.
removed from the chamber. The point that the
eluent had reached is called the eluent front
PREPARATION OF SAMPLE
and was immediately marked with a pencil. The
5g of aqueous extract was dissolved with eluent
plate was dried by allowing the eluent to
and equal amount of silica gel was added to it.
evaporate form the plate.
Mixed thoroughly by continuous stirring in one
direction till solvent got evaporated.
VISUALIZATION OF SPOTS ON TLC PLATE
A developed TLC plate was sprayed with Vanillin
METHOD[25, 26, 27]
sulphuric acid and visualized spots were
For column chromatography sample was loaded
marked. Distance travelled by solute and
on to the column packed with adsorbent silica
solvent was measured to calculate the
gel G (100-200 mesh). The mobile phase was
Retardation factor of solute using the following
added from the top of the column and allowed
equation
to flow down by gravity. Elutants was collected
Rf = Distance travelled by solute front
from the bottom of the column and was stored
Distance travelled by solvent front
as fractions of 10 ml. Each fraction was analyzed
by TLC and those with same pattern were
ISOLATION OF CHEMICAL CONSTITUTENT BY
pooled. Fifth fraction which gave a single spot
COLUMN CHROMATOGRAPHY
and Rf similar to the bioactive constituent, βPACKING OF COLUMN
sitosterol was evaporated and subjected to IR,
A cylindrical glass column was taken and
NMR and MASS spectroscopy studies.
plugged with a small piece of cotton.
Mounted the column on the stand.
RESULT
Weighed 20 g of fresh silica gel (for column
EXTRACTION YIELDS
chromatography 60-120 mesh) into a 250 mL
Extractive yields for each extract were
beaker.
calculated and Aqueous extract found have
more yield than other two extracts.
Table: Extractive Yields of Various Extracts of Clitoria ternatea
S.l:No:
Extracts
1
Hexane (HE)
2
Alcoholic (AE)
3
Aqueous (AQE)

Extractive Yield of dry Sample (g)
3.20
2.66
3.48

Preliminary screening
The preliminary phytochemical screening of hexane extract, alcoholic extract and aqueous extract were
done to identify the phytoconstituents and the results obtained were tabulated in the table.
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Table: Phytochemical Screening
Sl.No:
Chemical Tests
Observation
Detection of Alkaloids
Mayer's test
Yellow ppt
Wagner’s test
Reddish ppt
Dragendroff’s test
Red ppt
Hager’s test
Yellow ppt
Detection of carbohydrates
Violet ring at the junction of test
tube
Molisch’s test
Benedict’s test
Red ppt
Fehling’s test
Red ppt
Detection of Glycosides
Rose pink colour in
the ammonical layer
Modified Borntrager’s test
Legal’s test
Blood red colour
Detection of Phytosterols
Golden yellow colour
Salkowski’s test
Libermann Burchard’s’ test
Formation of brown ring at the
junction of test tube Yellow ppt
Detection of Phenols
Bluish black colour
Ferric chloride test
Detection of Flavonoid’s
Alkaline reagent test
Intense yellow colour
Lead acetate
yellow colour
Detection of Tannins
Ferric chloride test
Greenish ppt
Potassium Hydroxide
Dirty white ppt
Detection of Saponins
Formation of 1cm layer foam
Froth test
Foam test
Foam produced persists for ten
minutes
Detection of Proteins and
yellow colour
amino acids
Xanthoproteic test

HE
-

Inference
AE AQE
+
+
+
+
+
+
+
+

-

+
+
+

-

-

+
+

+

+
+

-

+
+

-

+

+

-

+

+
+

-

-

+
+

-

+
+

+
+

-

-

-

ANTI- CHOLINESTERASE ACTIVITY BY ELLMAN’S METHOD
The extracts were tested for their inhibitory effects against acetyl cholinesterase and compared with
neostigmine as standard. The results obtained were tabulated in the table
Table: Percentage inhibitions obtained for anti- cholinesterase assay
S.l.No:
Concentration
% Scavenging
1. Standard (Neostigmine)
25
68.53
50
82.64
75
83.25
100
84.88
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25
50
75
100
25
50
75
100
25
50
75
100

42.08
42.91
44.72
45.69
53.32
62.50
64.81
68.04
75.69
77.63
78.55
79.86

A graph was plotted taking Concentration on X-axis and percentage scavenging on Y-axis and results
were depicted in the figure
Figure: Concentration Vs. Percentage Inhibition

From the graph, IC50 values were calculated for
each extract and standard. The values were
tabulated in the table and graphically
represented in the figure
Table: Comparisons of IC50 values of various
Extracts with Neostigmine
S.l:No: Extracts
IC50 (µg/ml)
1
Neostigmine
10
(Standard)
2
Hexane
100
3
Alcoholic
22
4
Aqueous
12
Figure: Graphical representations of IC50 Values
of extract with Neostigmine

LIQUID
CHROMATOGRAPHY
MASS
SPECTROSCOPY
In order to identify chemical composition of the
bioactive extract, LC/MS studies were
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performed, and the identified constituents on
Library
comparison with data in class VP integrated
Table: Identified constituents by LC/MS
S.l:No:
Compounds
1
Kaempferol
2
Taraxerol
3
Beta- Sitosterol
4
Hexacosanol
5
Tyrosine
6
proline
7
Threonine
8
Lupeol
9
Ellagic acid
10
Catechin
11
Methyl amino- L- alanine
12
Amino butyric acid
13
Petunidin- 3-Glucoside
14
1,3,6 tri galloyl glucose
15
Sennoside A
16
Alpha- Crytoxanthin
17
Quinine
18
Alpha- Erythroidine
19
Di-methoxy 4- Hydroxyl Acetophenone
20
Lupinine

were

tabulated

in

the

table.

Molecular Weight
286.23
426.72
414.71
382.71
181.19
115.13
119.12
426.72
302.19
290.26
118.13
103.12
514.87
636.46
862.72
552.87
324.42
273.32
196.20
169.26

DOCKING STUDIES
In protein docking with 4FRJ, the docked poses were analyzed and lowest binding energy obtained and
the no: of hydrogen bond formed between protein and ligand were tabulated in the table
Table:In silico studies
Sl.No Compounds
1

2

Structure

Docking score
-6.58

Hydrogen Interaction
2

-3.67

1

Kaempferol

Taraxerol
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3

BetaSitosterol

4

Hexacosanol

5

Tyrosine

6

proline

7

Threonine

8

Lupeol

9

Ellagic acid

10

Catechin

11

Methyl
amino- Lalanine

12

13

-9.99

1

-1.54

0

-4.52

1

-3.50

1

-4.11

2

-9.61

1

-6.81

-

-6.07

3

-3.61

1

-2.87

1

-2.37

1

Amino
butyric acid
Petunidin3-Glucoside
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-6.21

6

14

1,3,6 tri
galloyl
glucose

15

Sennoside A

16

AlphaCrytoxanthi
n

+176.13

1

17

Quinine

-7.11

2

18

AlphaErythroidine

-6.89

0

19

Dimethoxy4- hydroxyl
Acetopheno
ne

-3.92

1

21

Lupinine

-5.57

2

+1623.37
1

Interaction of protein with best two ligand β - Sitosterol was depicted in the figure
Figure: Interaction of β – Sitosterol with Amyloid β protein
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Docking score (-9.99)
ISOLATION OF BIOACTIVE CONSTITUTENT
TLCprofile obtained for Aqueous extracts of Clitoria ternatea in various solvent system were tabulated in
table
Table: TLC profile
S.l:No
Sample
Mobile phase
Spot
Rf value
1.
Aqueous Extract
Toluene: Ethyl acetate (80:20)
1
0.64
Best TLC profile was obtained for Toluene: Ethyl acetate in the ratio 80:20 and the spot 1 showed Rf
value similar to β-sitosterol
Characterization of isolated compound
The isolated compound is a white crystalline compound, melting point experimentally found to be
138oc.IR Spectroscopy shown in (figure) reveals that OH Stretching (3292.58), C-H aliphatic stretching
(2925.90, 2855.42), C-O stretching (1228.00) CH2 stretching (1450.58), C=C stretching (1650.58). From
1
H- NMR (Figure) showed there were signals found in 0.793,1.06 due to 2 methyl singlet, 0.82 due to
methyl doublet , 0.835due to methyl triplet, 5.31 due to substituted olefinic bond. From C- NMR(Figure)
shows signals at 31.94, 21.46 and 29.71. The weak molecular ions were given at m/z 414 and other ion
peaks are m/z 271, 273 due to the formation of carbocation by β bond cleavage of side chain leading to
the loss ofC10H21 and C10H23 that corresponds to the M‐141and M‐143.
IR Spectrum of isolated compound
1

H-NMR Spectrum of isolated compound

PharmaTutor Magazine | Vol. 2, Issue 9 | magazine.pharmatutor.org

147

ISSN: 2347-7881

12

C-NMR Spectrum of isolated compound
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Structure of isolated compound
aqueous extract found to have higher activity
The physical and spectral
was compared with Neostigmine, activity was
data are consistent to the
comparatively less than standard. A graph was
reported literature values.
plotted concentration on x- axis and percentage
From the data’s of
inhibition on y-axis and IC50 values were
spectroscopic studies it
calculated. Chemical profiling of bioactive
was confirmed that isolated compound was βaqueous extract by LC-MS to identity chemical
sitosterol.
composition and obtained mass spectrum of
identified compounds were compared with
DISCUSSION
class VP integrated library. In silico studies on
Alzheimer’s disease is a neurodegenerative
identified compounds from LC-MS were docked
disorder due to the impairment of
with receptor Amyloid β protein (4frj) using
Acetylcholine. In traditional practices of
auto dock software. The highest docking score
Ayurvedic and Chinese medicine, numerous
was for β-sitosterol. Isolation of bioactive
plants have been used to treat cognitive
constituent was carried out by TLC studies and
disorders, including neurodegenerative diseases
column chromatography. Various solvent
such as Alzheimer's disease. The herbs acting on
systems were screened to select the best
the brain are called No-otropic herbs and their
solvent system (Toluene: Ethyl acetate) in the
isolated constituents are referred to as smart
ratio 80:20. TLC profiling of column fractions,
drugs. In my thesis work I selected Clitoria
fifth fraction gave similar Rf value (0.64) similar
ternatea for Alzheimer’s diseases, extraction
to β-sitosterol, the isolated compound was
was carried out by using different solvent based
subjected to spectroscopic analysis. The
on their polarity hexane, alcoholic and aqueous
identified compound may play vital role against
extracts and their yield were calculated. All
poor also in memory.
extracts were subjected to preliminary
CONCLUSION
photochemical screening to identify the
The present study shows the Aqueous extract of
phytoconstituents present in each extracts. The
Clitoria ternatea can be used against
activity of acetyl cholinesterase was done by
Alzheimer’s disease. The isolated compound
Ellmann’s method; used for monitoring
may act as a lead compound for identifying new
cholinesterase activity and also Ach hydrolysis
derivatives which could use for improving
by acetyl cholinesterase. From the study
memory.
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